EE2 ARM Experiment: PCB Design Tutorial

Version: 2.168  Date: January 13, 2016

I. INTRODUCTION

This section of work is designed to introduce you to the fundamentals of PCB design. The design that you will produce in the next two lab sessions will be used in the Summer term SWITCH experiment; a well-designed board could save you lots of debugging headaches! Your completed design will be an embedded computing platform with a microprocessor module, an OLED display and four touch switches.

This lab work will make use of the EDA (Electronics Design Automation) package called Altium CircuitMaker, which has similar functionality to the widely-used Altium Designer. CircuitMaker is free to use and you may find it useful for future personal and academic projects.

II. WHAT IS A PCB?

A PCB or Printed Circuit Board is a method of mounting and connecting many components together. It consists of a structural layer, usually made from a glass fibre composite, and a number of conducting and insulating layers on both sides. For this experiment we will have one conducting layer and one insulating layer on each side, but more complex designs can use many more. The conducting layer is made from copper and sits adjacent to the structural layer; tracks, solder pads and other features can be made in this layer by etching away sections to give isolated areas of copper. The conductive layer on the top can be connected to the conductive layer on the bottom by plated through holes (PTH), or vias, which are drilled holes that are then coated in conductive material. By using both layers and vias to connect between them complicated wiring can be achieved without any external wires being used.

After the conductive layers have been etched and vias added an insulating layer is added on top to avoid shorting. This is usually the characteristic green colour you will have noticed on most PCBs. This is done via a silk screen process. Optionally a final cosmetic layer on both sides can be added.

Learning Objectives

- Understand the basic layered structure of a PCB.
- Understand the affect of design rules in the design process.
- Be competent at designing a simple PCB using Altium Circuit Maker.
- Be aware of some of the trade-offs when laying out a PCB.

Deliverables

- Gerber File Deadline: 22/01/2016, 14:00

- Marking: Questions Unmarked, A functioning PCB will be a positive in SWITCH
which is usually referred to as ‘the Overlay’. This usually has small white numbers indicating the components that should be placed in particular places, version numbers of the board and other identification marking. See Figure 1 for a demonstration of these different layers.

Research: How are PCBs constructed with more than two copper layers?

Fig. 1: A complete PCB, silver rings are vias connecting to the other side, dark green lines show where the copper was etched away to form tracks to carry the signals. The green covering prevents short circuits. The white writing is a reference to help with construction.

III. SETTING UP ALTIUM CIRCUIT MAKER

Altium Circuit Maker uses cloud services for data storage and project management and a local piece of software to run the user interface. To use it, you must first register for an account by following the instructions here: http://www.circuitmaker.com/#download Lab PCs already have CircuitMaker installed so you can start the software and log in with your new account. If you want to install the software on your own PC follow the instructions in your registration confirmation email. Mac and Linux users will need to use a Windows virtual machine. For this experiment you will start with a partially set up project to save time, this is done by ‘forking’ an existing project. ‘Forking’ refers to making a copy of an existing project that is editable and owned by you. Go to ‘Open Project’ then in the search box type ‘PCB Lab’. Select the project created by Edward Stott, and click on ‘Fork’, rename the project to your group name and make it a ‘sandbox’ project, this makes it private until you are ready to release the design, a good would be NAME EEE TOUCHSWITCH, where NAME is your name. On your new project click ‘open’ (not on the schematic!) to open the project, the schematic file and PCB layout will now be available on the left hand side of the screen.

Task 1: Register for CircuitMaker and fork the PCB Lab project (changing the name of the project and making it a ‘sandbox’ project).

IV. PRODUCING A SCHEMATIC

Producing a working PCB first requires a correct electrical description of the circuit you wish to build. This is the function of a schematic, it shows what components are to be used and how they are connected together. Your project already contains a partially-complete schematic; double-click on it to open the schematic editor window. You will find the microcontroller module, OLED display and touch pads already placed. You will need to fill in the missing connections and add the circuitry to detect when the pads are touched.

The touch pads work by building an R-C oscillator. When the pad is touched, the finger introduces extra capacitance and the frequency of the oscillator reduces. The microprocessor will count the oscillator frequency and applies a threshold to decide if the pad is being touched or not. The circuit for the oscillator is shown in Figure 2.
Task 2: What values should be used for R and C in Figure 2? Aim for the oscillator frequency to be 100kHz normally and 50kHz when the pad is pressed. Assume the touch pad capacitance is 10pF and it increases to 50pF when it is touched.

The core of the oscillator is a Schmitt trigger inverter and there are six of these in a SN74HC14D, which is a standard logic integrated circuit. If you click on the tab ‘Libraries’ on the far right hand side of the interface a new sub-window will open. In the first drop down box select ‘Octopart’, which is the large open source component library. In the search box enter ‘SN74HC14D’, the first result should be an exact match, the other results are very similar chips with different packages. The first result should also have a small cube icon above the image, this indicates that the part has a footprint, 3D model or simulation model attached. If the component is lacking this then you would need to create these yourself.

Research: The component library in CircuitMaker is ‘crowd-sourced’. What are the pros and cons of this approach? How would you create your own custom component? How would a component library be managed in industry?

Select the first SN74HC14D listing, then under ‘Revisions’ pick the entry by ‘Edward Stott’ now you can select the through hole package from the shown footprint images (the last one). Now click ‘Place’, then press ‘tab’ and change the designator from ‘U?’ to ‘U3’, now place the IC on the schematic sheet, make sure you place all 6 sub parts! The ‘U3’ is called a designator and it uniquely identifies each physical component (U3 is represented on the schematic by the six sup-parts U3A–U3F). It is usual to use U for ICs and other relevant components are listed in in Table I. The other components that you will need for this design are given in Table II.

To connect components together use the ‘wire’ tool (hotkey = ‘w’). Your final design should look like Figure 3. Use the ‘Power ports’ tool too add symbols such as ‘GND’ and ‘VCC’ and for long connections, such the ones between the output of the oscillators and the Mbed, net labels are useful to keep the schematic neat and easy to read. It is useful to use the ‘Electrical Rules Check’ located in the ‘Outputs’ tab, this will list a variety of errors. You will have some errors regarding the power supply pins on the SN74HC14D, these can be safely ignored. Another convenient shortcut is the ‘space’ key when moving parts makes the selection rotate by 90 degrees, if the part is highlighted it will rotate around the origin.

Task 3: Draw four oscillator circuits, one for each touch pad. What should you do with the two unused inverters in the SN74HC14D?

Task 4: Connect the oscillator outputs to the OM11043 and complete the wiring to the OLED display. The display is controlled with an SPI bus. Which pins should you use on the OM11043 for these signals?

The circuit in Figure 3 is lacking decoupling capacitors. Decoupling capacitors are necessary to prevent noise from being transferred between components via their power supplies.

Task 5: Add decoupling capacitors to the circuit as appropriate.
TABLE I: Typical designators

<table>
<thead>
<tr>
<th>Component Type</th>
<th>Designator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integrated Circuit</td>
<td>U</td>
</tr>
<tr>
<td>Resistor</td>
<td>R</td>
</tr>
<tr>
<td>Capacitor</td>
<td>C</td>
</tr>
<tr>
<td>Connector</td>
<td>J</td>
</tr>
<tr>
<td>Inductor</td>
<td>L</td>
</tr>
<tr>
<td>Diode</td>
<td>D</td>
</tr>
</tbody>
</table>

TABLE II: Components used in this design

<table>
<thead>
<tr>
<th>Component</th>
<th>Search term</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capacitor</td>
<td>K104K15X7RF5TF3</td>
</tr>
<tr>
<td>Resistor</td>
<td>CFR16J470R</td>
</tr>
<tr>
<td>Schmitt Inverter</td>
<td>SN74HC14D</td>
</tr>
</tbody>
</table>

V. AUTOMATIC ANNOTATION

At this point most of the components will be designated in the form ‘C?’ and ‘R?’. These can be automatically enumerated by clicking ‘Tools’, ‘Annotation’, ‘Annotate Schematics Quietly’. It is possible to re-annotate the schematic using ‘Annotate Schematic’, it should propose sensible numbering.

VI. PERFORMING ELECTRICAL RULES CHECK

Now that you are coming to the end of the schematic capture it is very important to check for inconsistencies. Clicking on ‘Electrical Rules Check’ under the ‘Outputs’ tab
will generate a list of warnings and errors exhibited in your schematic. Some warnings, and at times errors, can be tollerated; you must judge which can be ignored. Good questions to ask are: Would this make the PCB fail? Would this make the design unclear to someone looking through it for the first time? You should perform ERC regularly through the process of designing a PCB to catch errors early before they become difficult to fix.

VII. PCB Layout

Once you are happy with the schematic you have generated, you are ready to design the physical PCB layout. There is a template PCB already in the project, double click it to open the PCB editor window. You can now import all the parts from the schematic. Goto the ‘Home’ tab then click ‘Project’ -> ‘Import Changes from ...’, then execute the changes. All your components should now be displayed. Click and drag them into your preferred arrangement, using the space key to rotate. To help you visualise the PCB you can press the ‘3’ key to enter 3D mode, press ‘2’ to re-enter the 2D view. Tips for arrangement:

- Parts with many pins should not be very close to the edge to allow for tracks to escape the area.
- Parts that are electrically connected together, generally should be near each other to minimise track length. The straight ‘rat’s nest’ lines give an indication of the wires you’ll need to create so look out for many crossing lines.
- Have all of the touch switches near the edge so they can be touched easily. Use the 3D view to help visualisation.

Task 7: Arrange parts on PCB.

A. Design Rules

This software provides a system for checking your design against a set of rules. The rules would usually be set by the manufacturing constraints provided by the PCB fabrication facility. Your project is already set up with fairly conservative rules to make it easier to solder, but click on ‘Design Rules’ in the ribbon to see the kinds of rules that are available. This is very important when you work on a large design, as the designer will not have the ability to manually check that everything on the board is sensible.

Research: What is a typical minimum width for a copper track and minimum gap between tracks on a commercial PCB?

B. Routing

Routing is the process of connecting the components using tracks. There are 2 main ways to do this, automatically and manually. Automatic is very useful to check if the design is easy to route, if it succeeds there are likely many different routing arrangements that will work, this is good! Though do keep in mind that a skilled human will find better routing strategy than the auto routing. Also the autorouter could make decisions that make the board function less well than if a careful designer added the tracks, for example keeping different high frequency tracks away from each other.

Try the autorouter first by clicking the ‘Tools’ tab, ‘Autoroute’, ‘All’. If your positioning of the components was reasonable then it should complete without errors and without the need for additional vias. Try the manual routing also. First clear the autoroute by going to the ‘Home’ tab, ‘Unroute’, ‘All’. Then using the ‘Route’ button you can click on signals and connect them with tracks. The tracks will automatically move other tracks out of the way. To add a via on the track press the ‘2’ key. To change the layer you are routing on press the ‘L’ key. You can either
continue this process or reuse the autoroute tool.

Task 8: Route the PCB. Which wires might be sensitive to noise and which wires might emit noise? Try to keep these apart.

C. Polygon Fill

Now that your PCB is routed it would function correctly if it were to be manufactured, though the board in this state is vulnerable to interference due to the lack of an adequate ground plane. Also the amount of copper that must be removed is very large and will use lots of etchant, which is bad for the manufacturer, the environment and for the cost of the boards to produce. The solution to both of these problems is to add a copper fill that is tied to the GND signal. We will need one on both sides of the board.

To add a polygon fill, select the ‘Polygon Pour’ button, a dialogue box will appear. Give it a name such as ‘Top GND’. Select the layer as ‘Top Layer’. Connect to net ‘GND’. Use the drop down box to select ‘Pour over all same net objects’, and select ‘Remove Dead Copper’. After pressing ‘OK’ you will be able to place the boundary lines of the copper pour along the board outlines (the fill will automatically be trimmed back according to the design rules). Setting a course grid may make this easier. Do the same for the bottom. Use the combination of ‘shift’ + ‘space’ to change the cornering style. Use ‘Escape’ key when finished and the pour will be added.

Task 9: Add copper fills to the PCB

Research: Notice that the pads that were already connected to ground now have small connections to the ground plane instead of flooding over them; why is this?

VIII. Final Touches

1) Add Group Name: Using the text tool, add your group name to the top overlay. Use the ‘tab’ key to change layers and other parameters of the text.

2) Arrange Designators: Move and reorientate the component designators so that they are logically placed around the components. Remember they won’t be visible underneath components! Any overlay that lies on top of component pin pads will be removed at manufacture.

Task 10: Finalise the top overlay.

IX. Design Rules Check

When producing batches of PCBs it is important that they meet the design rules that you looked at in Section VII. To run a check click the ‘Design Rules Check’ button, run the check with the default settings, this will bring up a summary of your warnings. Some of these are more critical than others, to see the source of an error scroll down and click on the error instance. Some errors may not be easily removed, make a decision whether you need to correct them or not. Anything regarding the silk layer will not affect the operation of the board, so use the 3D view to check if the silk screen is good enough for your purposes. Unrouted errors and clearance errors will affect the board operation and should be corrected.

Task 11: Review the results of the design rules check.

X. Design Extensions

During debugging and testing of this circuit you are likely to need to probe signals. You could use a header to give you a row of holes to probe, try finding a 6 pin header
with 2.54mm spacing in the parts library, similarly to how we imported components in Section IV. Alternatively you can do it directly in the PCB editor by adding pads connected to the signal of interest (press tab when in the pad tool and set the net, remember to route to it). You can add words to the silk screen layer using the string tool in the PCB editor, check your results using the 3D view.

Recommended test points:
- Vcc
- GND
- Output 1
- Output 2
- Output 3
- Output 4

Task 12 (optional): Add a test header.

XI. MANUFACTURING OUTPUTS

When all of the above is complete and you are happy with the design we must create files for the manufacturer to use to produce the boards. These are the Gerber and Drill files. To produce these click ‘Project’, ‘Generate Outputs’. Save and commit your work when prompted. A dialogue of all possible outputs will appear, spend a minute looking through them. Select ‘Gerber Files’ and ‘NC Drill Files’. Configure the Gerber files. Go to the ‘Layers’ tap and select ‘Plot’ for all of the following layers:
- Top Overlay
- Top Solder
- Top Layer
- Bottom Layer
- Bottom Solder
- Bottom Overlay
- Outline

Pressing ‘Generate’ will start the generation of the files, it will then offer for you to save a zip file containing all of the outputs, this is the file you should give as your final submission for this section. You can check that the files were generated correctly by using an online gerber viewer, such as http://www.gerber-viewer.com/.

Final Check:
- Schematic shown in Figure 3 is fully implemented.
- The two redundant Schmitt inverters are explicitly added to the schematic and dealt with appropriately.
- All designators are unique.
- The ERC passes with only well understood warnings.
- The PCB is synchronised with the schematic.
- The board size has remained unchanged from the original size.
- All of the signals are routed (no more air wires).
- There is a polygon fill connected to ‘GND’ on both sides of the board.
- Your group name is on the overlay.
- Your gerber files and schematic are submitted on LabWeb.

Task 13: Produce the manufacturing files for your PCB and submit them on LabWeb.